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Chapter 1

Introducing the SAP ALE eWay

The Sun SeeBeyond eWay™ Adapter for SAP ALE, also referred throughout this 
document as the SAP ALE eWay, provides an OTD wizard to build IDoc OTDs. These 
OTDs are used with the Sun SeeBeyond eWay™ Adapter for SAP BAPI to exchange 
IDoc data with SAP R/3.

What’s in This Chapter

About SAP ALE on page 5

About the SAP ALE eWay on page 6

What’s New in This Release on page 9

What’s in This Document on page 9

Sun Microsystems, Inc. Web Site on page 11

Documentation Feedback on page 11

1.1 About SAP ALE
SAP ALE (Application Link Enabling) is a technology for exchange of business data 
between multiple SAP R/3 systems or SAP R/3 and customer applications. The vehicle 
for data exchange is an IDoc (Intermediate Document), which is basically a SAP 
defined message structure that serves as a container for the different types of 
application data being transmitted.

ALE provides SAP customers with a program distribution model and technology that 
enables them to transfer IDocs across various platforms and systems.

1.1.1 The SAP IDoc Format
IDocs are used as containers for information, and are used to exchange business data 
between systems. 

Several hundred IDocs are supplied with each SAP R/3 system, serving as templates 
for a wide variety of applications. The IDoc hierarchy is represented by the following 
terminology:

Message Types are related to specific applications such as Orders.
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Introducing the SAP ALE eWay About the SAP ALE eWay
IDoc Types are different versions of standard Message Types, such as Orders for 
specific items or services.

A typical SAP IDoc consists of Control, Data, and Status records, as shown in Figure 1 
on page 6. Status records, however, are not used by the ALE interface.

Figure 1   SAP IDoc Structure

1.2 About the SAP ALE eWay
The SAP ALE IDOC Object Type Definition (OTD), when used with the SAP BAPI 
eWay in Transactional Remote Function Call (tRFC) mode, enables Sun Java Composite 
Application Platform Suite (Java CAPS) Projects to exchange data with SAP R/3 
software using SAP’s Intermediate Documents (IDocs) via the Application Link 
Enabling (ALE) interface. 

The next two sections provide an overview of how to use the IDoc OTD and the SAP 
BAPI eWay to send or receive IDocs to SAP R/3.

1.2.1 Inbound Data Flow: SAP R/3 to Java CAPS
The figure below describes the inbound data flow from SAP R/3 systems to Java CAPS. 
During routine operations, an application on the SAP R/3 system generates a 
transaction designated for an external system. The ALE interface converts the data from 
the internal data format to the IDoc format, and sends it via tRFC to the SAP BAPI 
eWay, acting as a RFC server. 

The Java CAPS Project’s business rules receive the IDoc data from the SAP BAPI eWay, 
performs any necessary processing or routing, and sends the information to another 

Sender Recvr Messg. Type IDoc-Type Status

Control Record

Data Record/Segments
HEADER1
ITEMS
SUBITEMA
SUBITEMB
TEXT
ITEMS
SUBITEMC

XXXXXXXXXXXXX
XXXXXXXXXXXXXXXXXXXXXXXXXX
XXXXXX
XXXXXX
XXXXXXXXXXXX
XXXXXXXXXXXXXXXXXXXXXXXXXXXX
XXXXXXX

SUBITEMD
ACCUM

XXXXXX
XXXXXXXXXXXXXXXX

Status Record
‘To be processed’ 14:33:48
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Introducing the SAP ALE eWay About the SAP ALE eWay
eWay connected to the recipient system. Any necessary data transformation required 
for the target application is performed in your Project Collaborations.

Figure 2   Inbound Data Flow: SAP R/3 to Java CAPS

The diagram in Figure 2 shows the following inbound message processing flow:

1 The eWay reads in the required configuration parameters and establishes a network 
connection with the SAP R/3 system. The eWay acts an RFC server, receiving IDocs 
from the SAP R/3 system.

2 When the IDoc is sent from SAP R/3 via tRFC, the SAP BAPI eWay uses the RFC 
OTD, IDOC_INBOUND_ASYNCHRONOUS, to receive the IDoc data. 

3 IDoc data received by the IDOC_INBOUND_ASYNCHRONOUS OTD can be 
marshaled out of the OTD and unmarshaled into a IDoc OTD.

4 A file-based TID (Transactional ID) database is used to track transactions that have 
been committed successfully or rolled back.

5 If identified successfully, the process moves on to the next step. If not, the eWay 
composes the appropriate response and logs an exception in the log file. 

6 If the Collaboration or Business Process fails, an exception is logged in the log file 
raised back to SAP R/3.

7 The eWay then repeats the procedure beginning with step 2.

BAPI
eWay

Target
ApplicationeWay

SAP R/3 System

IDoc

eGate Transformation

Idoc
OTD

File
TID

tRFC
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Outbound Data Flow: Java CAPS to SAP R/3

In the outbound mode, you must first get the data into the IDoc OTD using its 
unmarshal method. From the IDoc OTD, you unmarshal the data into the 
IDOC_INBOUND_ASYNCHRONOUS RFC OTD which sends the IDoc to SAP R/3 
using tRFC protocol.

Figure 3   Outbound Data Flow: ICAN to SAP R/3

The diagram in Figure 3 shows the following outbound message processing flow:

1 When the Collaboration or Business Process starts to run, the eWay is initialized 
with its configuration properties.

2 The data is unmarshaled to the IDoc OTD before being sent to the SAP BAPI eWay’s 
RFC OTD---IDOC_INBOUND_ASYNCHRONOUS.

3 The SAP BAPI eWay transmits the data to SAP R/3.

4 The SAP BAPI eWay associates the next TID (from a persistent resetable counter) 
with the transformed outbound message and sends it via tRFC to the SAP R/3 host.

5 If no exceptions are raised by the receiving SAP R/3 host, the next TID is 
incremented.

6 The eWay repeats the procedure beginning with step 2.

Messages are sent to the SAP R/3 host via Transactional RFC (tRFC). With tRFC, the 
receiving SAP R/3 system relies on an unique Transactional ID (TID) sent with the 
message to ascertain whether or not a transaction has ever been processed by it before. 

BAPI
eWay

Target
ApplicationeWay

SAP R/3 System

IDoc

eGate Transformation

IDoc
OTD

File
TID

tRFC
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The SAP BAPI eWay assumes that all messages handled are new and assigns a new TID 
to each message.

Note: If you have IDoc data in a byte array format you may unmarshal it directly to the 
IDOC_INBOUND_ASYNCHRONOUS OTD without using the IDoc OTD first.

Using the IDoc OTD with the Sun SeeBeyond eWay™ Adapter for SAP BAPI

Refer to the sample Projects and tutorials in the Sun SeeBeyond eWay™ Adapter for SAP 
BAPI User’s Guide on how to use the IDoc OTD along with the SAP BAPI eWay.

1.3 What’s New in This Release
The SAP ALE eWay includes the following new features:

What’s New in 5.1.2

Support for SAP ECC 6.0 (Unicode only)

What’s New in 5.1.1

Supports automatic deployment of EAR files to WebLogic Application Server 
(version 9.1).

What’s New in 5.1

Version Control: An enhanced version control system allows you to effectively 
manage changes to the eWay components.

Multiple Drag-and-Drop Component Mapping from the Deployment Editor: The 
Deployment Editor now allows you to select multiple components from the 
Editor’s component pane, and drop them into your Environment component.

Relaunchable OTD Support: An OTD can be rebuilt and saved (under the same 
name) then relaunched back to the same Java Collaboration or Business Process. 
This allows you to rebuild the OTD with changed metadata without having to 
completely recreate the business logic from scratch.

Support for IDoc extensions.

Support to build IDoc OTDs from SAP R/3 directly via IDoc type Lookups dialog.

1.4 What’s in This Document
This document includes the following chapters:

Chapter 1 “Introducing the SAP ALE eWay”: Provides an overview description of 
the product as well as high-level information about this document.

Chapter 2 “Installing the eWay”: Describes the system requirements and provides 
instructions for installing the Sun SeeBeyond eWay Adapter for SAP ALE.
eWay™ Adapter for SAP ALE User’s Guide 9 Sun Microsystems, Inc.



Chapter 1 Section 1.4
Introducing the SAP ALE eWay What’s in This Document
Chapter 3 “Using the SAP ALE OTD Wizard”: Provides instructions for creating 
Object Type Definitions to be used with the Sun SeeBeyond eWay Adapter for SAP 
ALE.

Chapter 4 “Configuring SAP R/3”: Describes the configuration settings and 
parameters of SAP R/3 in order to communicate with the SAP ALE eWay. 

1.4.1 Scope
This document describes the process of installing the SAP ALE eWay.

This document does not cover the Java methods exposed by IDoc OTDs. For 
information on the Java methods, download and view the SAP ALE eWay Javadoc files 
from the Enterprise Manager.

1.4.2 Intended Audience
This guide is intended for experienced computer users who have the responsibility of 
helping to set up and maintain a fully functioning Java Composite Application 
Platform Suite system. This person must also understand any operating systems on 
which the Java Composite Application Platform Suite will be installed (Windows and 
UNIX), and must be thoroughly familiar with Windows-style GUI operations.

1.4.3 Text Conventions
The following conventions are observed throughout this document.

1.4.4 Related Documents
The following Sun documents provide additional information about the Java 
Composite Application Platform Suite:

Sun SeeBeyond eGate™ Integrator User’s Guide

Composite Application Platform Suite Installation Guide

Table 1   Text Conventions

Text Convention Used For Examples

Bold Names of buttons, files, icons, 
parameters, variables, methods, 
menus, and objects

Click OK.
On the File menu, click Exit.
Select the eGate.sar file.

Monospaced Command line arguments, code 
samples; variables are shown in 
bold italic

java -jar filename.jar

Blue bold Hypertext links within 
document

See Text Conventions on page 10

Blue underlined Hypertext links for Web 
addresses (URLs) or email 
addresses

http://www.sun.com
eWay™ Adapter for SAP ALE User’s Guide 10 Sun Microsystems, Inc.
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Introducing the SAP ALE eWay Sun Microsystems, Inc. Web Site
1.5 Sun Microsystems, Inc. Web Site
The Sun Microsystems web site is your best source for up-to-the-minute product news 
and technical support information. The site’s URL is:

http://www.sun.com

1.6 Documentation Feedback
We appreciate your feedback. Please send any comments or suggestions regarding this 
document to:

CAPS_docsfeedback@sun.com
eWay™ Adapter for SAP ALE User’s Guide 11 Sun Microsystems, Inc.
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Chapter 2

Installing the eWay

This chapter describes how to install the SAP ALE eWay, its documentation, and the 
SAP ALE sample Projects.

What’s in This Chapter

Installing the SAP ALE eWay on page 12

ICAN 5.0 Project Migration Procedures on page 14

SAP ALE Integration Server Logging on page 16

2.1 Installing the SAP ALE eWay
The Java Composite Application Platform Suite Installer, a web-based application, is 
used to select and upload eWays and add-on files during the installation process. The 
following section describes how to install the components required for this eWay.

Refer to the readme for the latest information on:

Supported Operating Systems

External System Requirements

Java Composite Application Platform Suite Requirements

Known Issues

Note: When the Repository is running on a UNIX operating system, the eWays are loaded 
from the Java Composite Application Platform Suite Installer, running on a 
Windows platform connected to the Repository server using Internet Explorer.

2.1.1 Installing the SAP ALE eWay on a Java CAPS system
Follow the directions for installing Java CAPS in the Composite Application Platform Suite 
Installation Guide.

After you have installed eGate or eInsight, do the following:

1 From the Suite Installer, click the Administration tab, and then click the link to 
install additional products.

2 Select the following products from the eWay category:
eWay™ Adapter for SAP ALE User’s Guide 12 Sun Microsystems, Inc.
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Installing the eWay Installing the SAP ALE eWay
FileeWay—the File eWay is used by most sample Projects.

SAPBAPIeWay—used by the SAP BAPI eWay sample Projects. Select this eWay 
if you intend to connect to SAP R/3.

SAPALEeWay

Select the following in the Documentation category to upload the User’s Guide, 
Help file, Javadoc, and Readme for the Sun SeeBeyond eWay Adapter for SAP ALE:

SAPALEeWayDocs

3 Once you have selected all of your products, click Next in the top-right or bottom-
right corner of the Select Java Composite Application Platform Suite Products to 
Install box.

4 From the Selecting Files to Install box, locate and select your first product’s SAR 
file. Once you have selected the SAR file, click Next. Your next selected product 
appears. Follow this procedure for each of your selected products. The Installation 
Status window appears and installation begins after the last SAR file has been 
selected.

5 Once your product’s installation is finished, continue installing the Java Composite 
Application Platform Suite as instructed in the Composite Application Platform Suite 
Installation Guide. 

2.1.2 Adding the eWay to an Existing Sun Java Composite 
Application Platform Suite Installation

It is possible to add the eWay to an existing Sun Java Composite Application Platform 
Suite installation.

Steps required to add an eWay to an Existing Java CAPS installation include:

1 Complete steps 1 through 4 in Installing the SAP ALE eWay on a Java CAPS 
system on page 12.

2 Once your product’s installation is finished, open the Sun SeeBeyond Enterprise 
Designer and select Update Center from the Tools menu. The Update Center 
Wizard appears.

3 For Step 1 of the wizard, simply click Next.

4 For Step 2 of the wizard, click the Add All button to move all installable files to the 
Include in Install field, then click Next.

5 For Step 3 of the wizard, wait for the modules to download, then click Next.

6 The wizard’s Step 4 window displays the installed modules. Review the installed 
modules and click Finish.

7 When prompted, restart the IDE (Integrated Development Environment) to 
complete the installation. 
eWay™ Adapter for SAP ALE User’s Guide 13 Sun Microsystems, Inc.
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After Installation

You must incorporate the installed eWay components into a Project before using the 
intended functions. See the Sun SeeBeyond eGate™ Integrator User’s Guide for more 
information on incorporating the eWay into an eGate Project.

2.1.3 Extracting the Javadocs
The SAP ALE eWay includes Javadocs, which provide a list of classes and methods 
exposed in an IDoc OTD.

Steps to extract the Javadoc include:

1 Click the Documentation tab of the Suite Installer, then click the Add-ons tab.

2 Click the Sun SeeBeyond eWay SAP ALE Adapter link. Documentation for the SAP 
ALE eWay appears in the right pane.

3 Click the icon next to Javadoc and extract the ZIP file.

4 Open the index.html within each extracted file to view the Javadoc.

2.2 ICAN 5.0 Project Migration Procedures
This section describes how to transfer your current ICAN 5.0.x Projects to the Java 
Composite Application Platform Suite (Java CAPS), version 5.1.2. 

To migrate your ICAN 5.0.x Projects, do the following:

Export the Project

1 Before you export your Projects, save your current ICAN 5.0.x Projects to your 
Repository. 

2 From the Project Explorer, right-click your Project and select Export from the 
shortcut menu. The Export Manager appears.

3 Select the Project that you want to export in the left pane of the Export Manager and 
move it to the Selected Projects field by clicking the Add to Select Items (arrow) 
button, or click All to include all of your Projects.

4 In the same manner, select the Environment that you want to export in the left pane 
of the Export Manager and move it to the Selected Environments field by clicking 
the Add to Select Items (arrow) button, or click All to include all of your 
Environments.

5 Browse to select a destination for your Project ZIP file and enter a name for your 
Project in the ZIP file field.

6 Click Export to create the Project ZIP file in the selected destination.

Install Java CAPS 5.1.2

1 Install the Java CAPS 5.1.2, including all eWays, libraries, and other components 
used by your ICAN 5.0.x Projects. 
eWay™ Adapter for SAP ALE User’s Guide 14 Sun Microsystems, Inc.



Chapter 2 Section 2.2
Installing the eWay ICAN 5.0 Project Migration Procedures
2 Start the Sun SeeBeyond Enterprise Designer. 

Import the Project 

1 From the Sun SeeBeyond Enterprise Designer’s Project Explorer tree, right-click the 
Repository and select Import Project from the shortcut menu. The Import Manager 
appears.

2 Browse to and select your exported Project file. 

3 Click Import. A warning message, “Missing APIs from Target Repository,” may 
appear at this time. This occurs because various product APIs were installed on the 
ICAN 5.0 Repository when the Project was created, that are not installed on the Java 
CAPS 5.1.2 Repository. These APIs may or may not apply to your Projects. You can 
ignore this message if you have already installed all of the components that 
correspond to your Projects. Click Continue to resume the Project import.

4 Close the Import Manager after the Project is successfully imported.

Deploy the Project

1 A new Deployment Profile must be created for each of your imported Projects. 
When a Project is exported, the Project’s components are automatically “checked in” 
to Version Control to write-protected each component. These protected components 
appear in the Explorer tree with a red padlock in the bottom-left corner of each icon. 
Before you can deploy the imported Project, the Project’s components must first be 
“checked out” of Version Control from both the Project Explorer and the 
Environment Explorer. To “check out” all of the Project’s components, do the 
following:

A From the Project Explorer, right-click the Project and select Version Control > 
Check Out from the shortcut menu. The Version Control - Check Out dialog box 
appears.

B Select Recurse Project to specify all components, and click OK. 

C Select the Environment Explorer tab, and from the Environment Explorer, right-
click the Project’s Environment and select Version Control > Check Out from 
the shortcut menu.

D Select Recurse Environment to specify all components, and click OK.

2 If your imported Project includes File eWays, these must be reconfigured in your 
Environment prior to deploying the Project.

To reconfigure your File eWays, do the following:

A From the Environment Explorer tree, right-click the File External System, and 
select Properties from the shortcut menu. The Properties Editor appears.

B Set the inbound and outbound directory values, and click OK. The File External 
System can now accommodate both inbound and outbound eWays.

3 Deploy your Projects.

Note: Only projects developed on ICAN 5.0.2 and above with SAP ALE 5.0.3 can be 
imported and migrated successfully into the Java Composite Application Platform 
Suite.
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2.3 SAP ALE Integration Server Logging
You must add the logging property “STC.eWay.SAP.ALE” manually to the Module Log 
Level section of Integration Server Administration application if you want to change 
logging levels for the SAP ALE eWay in the Integration Server. See the Sun SeeBeyond 
eGate™ Integrator System Administration Guide for more details.
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Chapter 3

Using the SAP ALE OTD Wizard

The chapter describes how to use the SAP ALE OTD Wizard to create IDoc Object Type 
Definitions (OTDs). OTDs are used in the business logic in Java Collaboration 
Definitions and eInsight Business Processes. 

What’s in This Chapter

About the SAP IDoc Wizard on page 17

SAP JCo and SAP IDoc Class Library Installation on page 18

Creating IDoc OTDs on page 20

Exporting the IDOC File from SAP R/3 on page 29

3.1 About the SAP IDoc Wizard
The SAP IDoc wizard is used to create IDoc OTDs. These OTDs can then later be used 
in Collaboration Definitions to create the business logic behind the Collaborations.

You can create IDoc OTDs in one of two ways:

Let the IDoc wizard connect and retrieve the IDoc message format directly from the 
SAP R/3 system.

Provide the location for a saved IDoc description file.

Figure 4   SAP IDoc Wizard Overview

To export an IDoc description file from an SAP R/3 system to be used by the IDoc 
wizard, see “Exporting the IDOC File from SAP R/3” on page 29. Separate instructions 

IDoc 
Wizard

IDoc
Description

File

IDoc
OTDsSAP R/3

IDoc
Message 

Description
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are included for versions 4.6 and earlier and 4.7 and later due to the significant SAPGUI 
changes that distinguish those versions.

3.2 SAP JCo and SAP IDoc Class Library Installation
Certain JAR files are required by the SAP ALE OTD Wizard to create IDoc OTDs.

From the SAP Java Connector:

sapjco.jar

From the SAP Java Base IDoc Class Library:

sapidoc.jar

From the SAP Java Connector IDoc Class Library:

sapidocjco.jar

3.2.1 SAP Java Connector
The SAP Java Connector file, sapjco.jar, is a middleware component that enables the 
development of SAP-compatible components and applications in Java. This component 
is required to support inbound and outbound SAP server communication during 
runtime.

Since we are installing the SAP Java Connector as standalone component, certain 
installation files are required. Download the installation files from SAPNet at 
service.sap.com/connectors. Once logged in, this link redirects you to SAP Service 
Marketplace. Click the following links to access the SAP Java Connector (SAP JCo) tools 
and services page:

SAP NetWeaver > SAP NetWeaver in Detail > Application Platform > 
Connectivity > Connectors > SAP Java Connector > Tools & Services

Procedures (Windows 32)

The following instructions apply for Windows 32 operating systems. 

1 Create a directory, for example C:\SAPJCo, and extract the JCo ZIP file into this 
directory.

2 Copy the files librfc32.dll and sapjcorfc.dll from your SAP JCo main directory to 
C:\WINNT\SYSTEM32, as long as the version that is already there is not a more 
recent version than the one that is delivered with the SAP JCo.

3 Copy the file sapjco.jar from your SAP JCo main directory to 
<JavaCAPS51>\edesigner\lib\ext, where <JavaCAPS51> is the Sun Java 
Composite Application Platform Suite install directory. 

4 The sapjco.jar file is also required during runtime. For this, add the JAR file to 
<JavaCAPS51>\logicalhost\is\lib. 
eWay™ Adapter for SAP ALE User’s Guide 18 Sun Microsystems, Inc.
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5 Download the following DLL files. These are available, free of charge, from various 
sources on the Internet:

msvcp71.dll

msvcr71.dll

You must manually add these files to the following location:

c:\WINNT\system32

Note: Restart both Enterprise Designer and the domain after installing the JAR file.

Procedures (UNIX)

The instructions for the installation of SAP JCo on other operating systems are included 
in the corresponding download files. On UNIX operating systems, add the OS specific 
shared lib files to the library path. Check the SAP BAPI eWay readme to confirm the 
supported operating systems.

3.2.2 SAP Java IDoc Class Library
The SAP Java IDoc Class Library consists of two parts, the SAP Java Base IDoc Class 
Library and the SAP Java Connector IDoc Class Library.

The packages of the SAP Java IDoc Class Library include the software as well as 
documentation. The SAP Java Base IDoc Class Library provides an API which helps 
navigating, reading, filling, and modifying IDocs. This base package is middleware 
independent. Creating, sending, and receiving IDocs is middleware dependent.

Like the SAP Java Connector, you download certain installation files from SAPNet at 
service.sap.com/connectors. Click the following links to access the SAP Java Connector 
(SAP JCo) tools and services page:

SAP NetWeaver > SAP NetWeaver in Detail > Application Platform > 
Connectivity > Connectors > SAP Java Connector > Tools & Services 
> SAP Java IDOC Class Library

This page contains links to the SAP Java Connector IDoc Class Library 1.0.6, and the 
SAP Java Base IDoc Class Library 1.0.3. To install these libraries, uncompress and 
extract the archives into the same directory as the SAP Java Connector installation path 
<sapidocjco-install-path>. Then load <sapidocjco-install-path>/docs/idoc/jco/
intro.html into your browser and follow the description under the link Installation.

Note: The SAP Java Connector file, JCo version 2.1.6 is not backwards compatible with 
previous versions, such as 2.1.3. Confirm backwards compatibility issues with SAP 
before attempting to switch between different JCo versions on different machines. 

Note: We recommend only using the directory path when setting your library path, not 
the directory path and file name.

Note: JCo 2.1.6 does not support mixed case, users may need to convert passwords to 
upper case for all design time and runtime SAP connection configurations.
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Note: You need to copy the JCo JAR file to the \compile\lib\ext folder before 
deploying and running command line codegen. You also need to copy the JCo JAR 
file to the c:\Sun\ApplicationServer\lib folder before deploying and 
running via the Sun Java™ System Application Server Enterprise Edition 8.1.

Note: You also need to copy the sapjco.jar, sapidoc.jar, and sapidocjco.jar files to the 
c:\bea\weblogic91\samples\domains\wl_server\lib folder before 
deploying and running via the WebLogic Application Server, version 9.1. When 
using CommandLineCodegen, please place sapjco.jar in 
<JavaCAPS51>commandlinecodegen\compile\lib\ext.

3.3 Creating IDoc OTDs
You create IDoc OTDs with the SAP IDoc wizard in the Enterprise Designer. You can 
choose to have the wizard connect to the SAP R/3 system and retrieve the IDoc 
message format automatically, or you can have the wizard use an IDoc definition file 
from a specified location. The IDoc definition file would be saved or downloaded from 
the SAP R/3 system as described in “Exporting the IDOC File from SAP R/3” on 
page 29.

To create IDoc OTDs from SAP directly

1 In the Explorer tab of the Enterprise Designer, right click a Project, then click New > 
Object Type Definition. The New Object Type Definition Wizard appears.

Figure 5   New Object Type Definition Wizard

2 Click SAP IDoc and click Next. The Select metadata page appears.
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Figure 6   IDoc Wizard—Metadata Selection

3 To retrieve the IDocs message format directly from the connected SAP R/3 system, 
select the From SAP Directly, then click Next.

Note: Refer to SAP JCo and SAP IDoc Class Library Installation on page 18 for a 
list of required files that must be installed in order to connect to SAP directly. 

4 Click Next. The System Parameters page appears.
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Figure 7   IDoc Wizard—System Parameters

5 Enter the information for the SAP R/3 system for the IDoc wizard to connect to:

6 Click Next. The Login Parameters page appears.

For this option Enter

System ID System ID of the SAP R/3 system.

Application server Name of the SAP R/3 Application Server.

System number System number of the SAP R/3 system.

SAP Routing String Router string of hostnames/IP addresses 
of all SAP routers between your Logical 
Host and the SAP gateway host (optional).

Language Language used for SAP R/3 access.
Available Languages include:

EN - English
DE - German
JA - Japanese
KO - Korean

RFC Trace NO to disable RFC tracing (default); YES to 
enable RFC tracing, which creates trace 
files in \edesigner\bin\.
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Figure 8   IDoc Wizard—Login Parameters

7 Enter the information to log into the SAP R/3 system:

8 Click Next. The IDoc Metadata Parameters page appears.

For this option Enter

Client Number Client number of the SAP R/3 system.

User name User name.

Password Login password.
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Figure 9   IDoc Wizard—IDoc Metadata Parameters

9 Enter the following information about the IDoc:

For IDoc type, click the List IDocs button to display a list of available IDocs 
supported by SAP R/3, as seen in Figure 10.

For this option Enter

System Release The SAP R/3 System release for this IDoc. 
All IDocs up to this release number are 
displayed in the list of available IDocs.

IDoc type IDoc type, for example, CREMAS03. You 
cannot use a wild card.

IDoc type extension Extension for this IDoc type (optional).

Record Type Version Select the version of the IDoc record type. 
The default value is 3.

Message format Blank padded for ALE format or CR-LF for 
EDI format.
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Figure 10   IDoc Type List

10 Select your needed IDoc type and click OK.

11 Click Next. The Review Selection page appears.

12 Review your selections and click Finish. The OTD Editor window appears, 
displaying the OTD. 
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Figure 11   CREMAS IDOC OTD

13 Figure 11 shows a CREMAS IDoc OTD in the OTD editor. The OTD has various 
methods which you can use in Java Collaborations for processing IDoc data. 

14 The CREMAS IDoc OTD also has marshal and unmarshal Web Service operations 
as seen in the Project Explorer. You can use these operations when using the OTD in 
eInsight business processes. 

Figure 12 shows the unmarshal operation in the eInsight Business Process editor. 
You can unmarshal byte or string data onto the IDoc OTDs bytes and contents 
nodes respectively. The bytes node takes in only UTF-8 encoded data. That is, if you 
want to perform an unmarshal operation using bytes as the input source, then you 
must ensure that the data is in UTF-8 before utilizing this node. 

In this example we are unmarshaling byte data which is not UTF-8 encoded; 
therefore, you must perform a bytes to text conversion in editor, and then 
unmarshal string data to the contents node. 
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Figure 12   CREMAS unmarshal

If required, you can also use the Relaunch option of the OTD to relaunch the IDoc 
OTD wizard, see Figure 13, and rebuild the IDoc OTD for the same IDoc Type built 
with a particular system release. 

On relaunch, the OTD is rebuilt again with the changed meta data. Any Java 
Collaborations and Business Processes using this IDoc OTD are also synchronized 
with the new changes.

If your Java Collaborations or business Processes are using OTD nodes that are now 
absent in the relaunched OTD, you will be prompted to correct the business rules by 
validation errors.

Figure 13   Relaunching the OTD

To create IDOC OTDs from a description file

1 In the Explorer tab of the Enterprise Designer, right click the Project, click New, and 
click Object Type Definition. The New Object Type Definition dialog box 
appears.

2 Click SAP IDoc and click Next. The Select metadata source page appears.
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Figure 14   IDoc Wizard—Metadata Selection

3 To retrieve the IDocs from a description file, select the From Description File.

4 Click Next. The Definition File Parameters page appears.

Figure 15   IDoc Wizard—Definition File Parameters
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5 Enter the following information about the IDoc definition file:

6 Click Next. The Review Selection page appears.

7 Review your selections and click Finish. The OTD Editor window appears, 
displaying the OTD.

3.4 Exporting the IDOC File from SAP R/3
The following sections describe how to create and export the IDOC file from SAP R/3. 
The procedures provided may vary depending on version and/or platform of SAP R/3. 
Refer to the current documentation for your version of SAP R/3. The procedures 
described in this section create the IDOC file an SAP R/3 system version 4.6 and earlier:

Downloading the IDoc Description File (Before 4.7) on page 29

Saving the IDoc Description File (After 4.6) on page 33

3.4.1 Downloading the IDoc Description File (Before 4.7)

Note: The screenshots in the procedure below show the SAPGUI version 6.2 connecting to 
segment version 4.6.

To download the IDoc description file from SAP

1 Log into the SAPGUI, and close the system messages. The SAP Easy Access 
window appears.

If the SAP Easy Access window does not display, click Exit.

For this option Enter

IDoc File Name The path and filename for the IDoc 
description file to be used.

Released In SAP R/3 IDoc release for this IDoc, for 
example, 4.6C.

Message format Blank padded for ALE format or CR-LF for 
EDI format.
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Figure 16   SAP Easy Access Window

2 Double-click WE63. The Documentation IDoc Record Types window appears.
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Figure 17   Documentation IDoc Record Types Window

3 In the Basic Types box, type or select the IDoc to be parsed.

4 Select any other options needed, and click Execute. The Documentation IDoc 
Record Types window shows the parsed definition file.
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Figure 18   Documentation IDoc Record Types Window—Parsed Definition File

5 On the System menu, click List, Save, and then Local File. The Save List in File 
dialog box appears.

Figure 19   Save List in File Dialog box

6 If necessary, select Unconverted.

7 Click Save. The Save As dialog box appears.

8 Navigate to the folder where you want to save the description file and click Save. 
The Transfer List to a Local File dialog box displays.
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Figure 20   Transfer List to a Local File Dialog Box

9 Enter the name and path of the local file to receive the IDoc description file.

10 Click Transfer. This downloads the file.

Once you have downloaded the IDoc description file, create the IDoc OTD using the 
IDoc wizard as described in “Creating IDoc OTDs” on page 20. Use the From 
Description File option so that you can select the description file you downloaded.

3.4.2 Saving the IDoc Description File (After 4.6)
Follow the instructions below to download an IDoc description file from an SAP R/3 
system version 4.7 and later.

Note: The screenshots in the procedure below show the SAPGUI version 6.2 connecting to 
segment version 4.7.

To save the IDoc description file from SAP

1 Log into the SAPGUI, and close the system messages window. The SAP Easy 
Access window appears.

If the SAP Easy Access window does not display, click Exit.
eWay™ Adapter for SAP ALE User’s Guide 33 Sun Microsystems, Inc.



Chapter 3 Section 3.4
Using the SAP ALE OTD Wizard Exporting the IDOC File from SAP R/3
Figure 21   SAP Easy Access Window

2 Double-click WE63. The Documentation window appears as shown below.

Figure 22   Documentation Window

3 Enter the basic type, enhancement, and segment type information.
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4 Select the IDoc record types to be included.

5 Click Parser. The Documentation window displays the parsed data.

Figure 23   Documentation Window—Parsed Definition File

6 On the System menu, click List, Save, and then Local File. The Save List in File 
dialog box appears.

Figure 24   Save List in File Dialog box

7 If necessary, select Unconverted.

8 Click Save. The Save As dialog box appears.

9 Navigate to the folder where you want to save the description file and click Save.

Once you have saved the IDoc description file, create the IDoc OTD using the IDoc 
wizard. Use the From Description File option so that you can select the description file 
you saved.
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Configuring SAP R/3

You can send/receive IDocs to a SAP R/3 system by using the IDoc OTD along with the 
SAP BAPI eWay to send/receive IDocs to SAP R/3. You must configure the SAP R/3 
system as described in this chapter.

The SAP screen captures in this chapter correspond to SAPGUI version 6.2, and
SAP R/3 version 4.0. They are included to illustrate the general nature of the 
procedures, and contain only example values. Refer to the documentation supplied 
with your SAP R/3 system to determine the exact procedures.

What’s in This Chapter

SAP Hierarchies on page 36

Naming the Logical System on page 38

Specifying the Distribution Model on page 40

Defining the RFC Destination on page 44

Defining the Communications Port on page 48

Creating a Partner Profile on page 49

Configuring a Partner Profile on page 51

Security Issues on page 54

4.1 SAP Hierarchies
To prepare your SAP R/3 system to recognize the SAP ALE eWay, you must first define 
a Logical System in SAP R/3 to represent the eGate system as an ALE client (either 
sender or receiver). Next, you create a new Distribution Model view, which defines 
how the Logical System exchanges messages. You must link it to a Client, a Logical 
System (the one you just created), and an IDoc type. The Distribution Model hierarchy 
is depicted in Figure 25, as it appears in the SAP GUI (IMG).
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Figure 25   Distribution Model Hierarchy

Following this high-level setup, you need to define Communications parameters in 
SAP to specify the correct routing of IDocs (either inbound to or outbound from SAP). 
The hierarchy of this Communication system is shown in Figure 26. The individual 
steps involved in the configuration are:

Figure 26   Communications Hierarchy

The RFC Destination defines the entity to which Remote Function Calls (RFCs) can be 
made; it is the same as the Logical System in the Distribution Model. The 
Communications Port defines a channel for communication of IDocs. The Partner 
Profile acts as an identifier for the eGate system, and provides a communications 
gateway by incorporating elements of the ALE interface.

Distribution
Model View

Client

Logical System
Name (eWay)

IDoc Name

RFC Destination

Communications 
Port

Partner Profile
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4.2 Configuring the Distribution Model
You need to complete the following in SAP R/3 to run a tRFC BAPI inbound.

Naming the Logical System on page 38

Specifying the Distribution Model on page 40

4.2.1 Naming the Logical System
Transaction: SALE

Figure 27   SAP R/3 System Window

1 In the SAP R/3 System home window, type SALE into the command field and click 
Enter to display the Distribution (ALE) Structure window.
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Figure 28   Distribution (ALE) Structure Display Window

2 Expand the tree to display IDoc Interface / Application Link Enabling (ALE) > Basic 
Settings > Logical Systems > Define Logical System.

3 Click the Activity button to select Define Logical System. This displays the Logical 
Systems Overview window.

4 Click the New entries button to display the New Entries window.

5 Enter the logical name for your SAP eWay using capital letters and a brief 
descriptive name.

Figure 29   New Entries Window
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6 Click Save. The Change Request Entry window appears.

Figure 30   Change Request Entry Window (1)

7 Click the Create request button, to display the Create Request window.

8 Enter a short description (e.g., eWay Test) and click Save. The Change Request 
entry window appears.

9 Click Enter to add the new data into the system. You are now returned to the 
Logical Systems Overview window, and the new Logical System appears in the 
list.

10 Click Save and select the Back button repeatedly until the SAP R/3 System window 
appears.

4.2.2 Specifying the Distribution Model
Cautionary Notes

Two notes of caution are appropriate at this point:

You should use the Z prefix when defining a name. This prefix is reserved for external 
use, and is not used in any standard SAP names.

Following these rules should prevent any interference with standard SAP functionality 
or conflicts with standard SAP terminology.
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Transaction: SALE

Figure 31   SAP R/3 System Window

1 In the SAP R/3 System home window, type SALE into the command field and click 
Enter to display the Distribution (ALE) Structure window.

Figure 32   Distribution Structure Window

2 Click the Activity button next to Maintain Distribution Model and Distribute 
Views to display the Maintain Distribution Model window.
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Figure 33   Maintain Distribution Model Window

3 Select the Menu path Edit > Model View > Create to display the Create Model 
View dialog box.

Figure 34   Create Model View Dialog Box

4 Enter the logical name you want for the new Distribution Model View, along with a 
brief descriptive name or message (for your own use).

5 Click Continue (Enter), which returns you to the previous window. Your new 
Model View now appears in the tree, as shown in Figure 35.
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Figure 35   Maintain Distribution Model Tree

6 Highlight the new entry and select Add Message Type. This displays the Add 
Message Type dialog box.

Figure 36   Add Message Type Dialog Box

7 Type the desired values for the four parameters into the text boxes, or select them 
from the drop-down menus. For example, CREMAS is the message type used for 
Creditor Master Data.

8 Select Continue (Enter), which returns you to the previous window. The values you 
select now appear in the Distribution Model tree, as shown in Figure 37.
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Figure 37   Maintain Distribution Model Tree

9 Save your entry, click Back and then Cancel to return to the Distribution Structure 
window.

4.3 Configuring Communications
This section describes the necessary communication configuration.

Defining the RFC Destination on page 44

Defining the Communications Port on page 48

Creating a Partner Profile on page 49

Configuring a Partner Profile on page 51

4.3.1 Defining the RFC Destination
Transaction: SM59

An RFC connection must be defined from the sender to the recipient. The first step is to 
define the RFC Destination.
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Figure 38   SAP R/3 System Window

1 In the SAP R/3 System home window, type SM59 into the command field and click 
Continue (Enter) to display the RFC Destination Maintenance window.

Figure 39   RFC Destination Maintenance Window

2 Select the TCP/IP connections option and then Create to display the RFC 
Destination entry window.
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Figure 40   RFC Destination Entry Window

3 Type in the name of the RFC Destination (use the Logical System name), an 
accompanying Description, and enter <T> for the Connection Type (TCP/IP).

4 Click Save to return a confirmation message and display the RFC Destination 
window corresponding to your entry.
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Figure 41   RFC Destination Window

5 Click Registration for the Activation type and type in a Program ID of the form 
<hostname>.<program name>, and a Description.

6 Click Test Connection, which tests the connection for logon speed and message 
transfer speed. When the eWay is running, the results are displayed in a table; 
otherwise, return code 3 is displayed.

Figure 42   Connection Test Results
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7 Click Save and select Back repeatedly to return to the SAP R/3 System window.

4.3.2 Defining the Communications Port
This section describes how to set up the communication port for Transactional RFC.

Transaction: WE21

The Communications Port defines the type of connection with the Partner (see Creating 
a Partner Profile on page 49). In this step you specify the outbound file name, directory 
path, and any associated function modules.

Figure 43   SAP R/3 System Window

1 In the SAP R/3 System home window, type WE21 into the command field and click 
Continue (Enter) to display the WF-EDI Port Definition window.

Figure 44   WF-EDI Port Definition Tree

2 Expand the tree under Transactional RFC to display the currently-defined Ports.

3 Select the desired Port from the list, or select Change to display the Port Definition 
for Asynchronous RFC Overview window.
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Figure 45   Port Details Window

4 Type in a Version (specifies IDoc record type), Logical destination, and Description, 
matching the entries made previously.

5 Select Enter, which displays the Change Request Query dialog window. [Note that 
you must have CTS (Correction and Transport System) turned on for this screen to 
be displayed.]

6 Select Create Request, which displays the Create Request dialog window.

7 Enter a Short description and Save. 

8 Select Back repeatedly to return to the SAP R/3 System window.

4.3.3 Creating a Partner Profile
Transaction: WE20

Here you create the Partner for the Logical System you created earlier. Note that the LS 
Partner Type is used for all ALE distribution scenarios.

Figure 46   SAP R/3 System Window

1 In the SAP R/3 System home window, type WE20 into the command field and then 
click Continue (Enter) to display the Partner Profile: Initial Screen window.
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Figure 47   Partner Profile: Initial Screen Window

2 Type the name of the logical system created previously into the Partner number 
field, select LS for the Partner type, and select Create. This creates the Partner, and 
displays the Create Partner Profile <Partner Number> window.
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Figure 48   Create Partner Profile Window

3 Select ALE for the Partner class and A (Active) for the Partner status, then Save. You 
now have created the Partner, and need to continue to the next section to configure 
the Partner Profile.

4.3.4 Configuring a Partner Profile
Transaction: WE20

In this section, you configure the Inbound or Outbound Parameters in the Partner 
Profile. 

1 In the Partner Profile: Initial Screen window, select the desired Partner Number, 
for example ZSRINI.

2 Select the Inbound parameters.
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Figure 49   New Entries: Details of Created Entries Window

3 Select CREMAS as a Message type and CRE1 as a Process code from the drop-down 
menus, then click Save. The entries now appear in the list in the EDI Partner 
Profile: Inbound Parameters Overview window.
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Figure 50   EDI Partner Profile: Inbound Parameters Overview Window

4 Follow the same procedure for Outbound parameters, as seen in Figure 51.
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Figure 51   EDI Partner Profile: Outbound Parameters

5 After making your entries, Save and then Back to get to the main SAP R/3 System 
window.

4.4 Security Issues
SAP uses authorization objects to allow access to various levels of operation. A minimum 
set of authorization objects required for the ALE eWay to operate is described below. 
Please use this only as a reference for setting up your own profiles.

These settings are located under Cross-Application Authorization Objects. Please refer 
to your SAP R/3 documentation for additional information.

Function Group Access

Under Auth. check for RFC access, select:

ARFC

EDIN

ERFC
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RFC1

SCCR

SYST

ZDG1

Permission for Processing IDoc Type

Under ALE/EDI > Distributing master data and ALE/EDI, select:

Receiving IDocs via RFC
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